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Introduction to the Tutorial
This tutorial is intended to familiarize you with the basic business profitability
modeling concepts that are used in SAS Profitability Management software. To complete
the profitability modeling process, move through this tutorial from beginning to end
exactly as it is presented.
Even though you may be familiar with the concepts of SAS Profitability Management
and customer detailed profitability reporting, working through this tutorial will make
you familiar with the SAS Profitability Management software – the concepts,
terminology, commands, dialog boxes, and Web reporting tools.
The key to computing segment profitability is the ability to accurately associate costs
with business segments. The heart of the problem is the difference in how revenue and
costs are managed and tracked in accounting systems. Revenue is generated by the
customer. It is usually automatically associated with business segments by sales order,
invoicing, or funds transfer systems. This makes it relatively easy to perform business
segment analysis using revenue alone. In contrast, costs are not as easily associated
with business segments. IT, operations, support, distribution, and administration
functions generally support many business segments simultaneously.
These shared and indirect costs should ideally be tracked based on logical cause-andeffect relationships to products, services, channels and customers. Traditional cost
systems violate this process by using arbitrary cost allocations with broad averages
(such as the number of customers).
SAS Profitability Management is a highly flexible analysis tool that provides the
ability to associate a cost and revenue with individual business transactions. Using the
software, you can calculate profit and loss based on individual transactions. SAS
Profitability Management provides the level of reporting detail that allows business
managers to actively manage profit as a performance metric. The product enables
business managers to track the profit performance of customer groups or individual
customers, product groups or individual Stock-keeping units (SKU), channels or specific
branches or combinations of these dimensions, or others as defined by the customer.
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Technical Support
If you encounter problems that you cannot solve by reading the online help or this
tutorial, refer to the SAS technical support home page at:
http://support.sas.com/techsup/intro.html.
Our support goal is to provide you with the resources you need to answer any
questions or solve any problems you encounter when using SAS software. We provide a
variety of tools to help you solve problems on your own and a variety of ways to contact
our technical support staff when you need help. Free technical support is available to all
sites licensing SAS software. This includes unlimited telephone support for customers in
North America. Customers outside of North America should contact their local SAS
office.

Additional Training and Documentation
Additional training and tutorials can be found at www.sas.com and
www.bettermanagement.com. Bettermanagement.com offers in-depth domain content
about selected management concepts that are aimed at improving an organization’s
performance. The Web site is a comprehensive source for performance management
information and resource including Web casts, white papers, training, and tutorial
materials. Topics that are covered on the Web include value-based management,
profitability analysis, strategic enterprise management, activity-based costing and
management, business intelligence, analytic analysis, scorecarding, and performance
measurement.
The documentation for SAS Profitability Management can be found at
http://support.sas.com/documentation/onlinedoc/pm/.

Business Requirements for Profitability Management
Profitability management is the most significant issue for any corporation.
Profitability is derived from both analyzing the revenue performance for a given
business dimension (customer, product, region, channel, customer segment), and
analyzing the costs directly associated with serving those customers and providing those
products. The critical challenge for business is to appropriately correlate revenue and
costs into a meaningful profit and loss statement at the level of detail.
In the growing level of corporate complexity and detailed transactional information
tracing corporate and customer interactions, detailed data analysis can be
overwhelming. Business managers need a clear tool to deal with millions of detailed
transactions and to produce an actionable profit and loss statement at a customer
detailed level. Businesses with millions of customer transactions have the most to gain
from implementing SAS Profitability Management. This solution is most crucial in the
telephone and banking industries, where customer differentiation can be most decisive
to overall corporate profitability.

Introduction
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With SAS Profitability Management, decision makers can define the segmentation
reports that they need on the fly. SAS enables business managers to drill-down into
revenue and cost categories so they can manage profit as a performance metric.

Reporting Solutions that SAS Profitability Management Provides
SAS Profitability Management matches cost and revenue behaviors to detailed
transactions. The association of the behaviors to the transactions is based upon a
wizard-driven rules engine. The resulting calculated detailed transaction tables are then
used as source content for a profit and loss statement.
The web-deployed profit and loss statement that SAS Profitability Management
provides:


Is based upon a custom-defined report layout and can support complex calculation
logic to present your company’s reporting needs



Is drillable for increasing level of details (revenue breakdowns or contributing
costs details)



Is drillable based upon dimensional hierarchies



A summary cube report that can be:
• Created to include only specific dimensions
• Summarized by depths noted in any dimension
A detailed cube report that can be:
• Defined with filter logic for a single dimension member
• Run on the fly.
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Company Background
The Baby Bank is a small sample model focused on the banking industry. The
company has branches and also services customers through call centers. It performs
both retail and corporate banking. They are trying to produce customer profitability so
that the banking managers can view the details of a customer’s behavior and
profitability value to Baby Bank. By having this detailed profit and loss information at
the managers’ fingertips, they can make better management decisions on how to service
the existing customers and what specific types of customers to focus on.

Baby Bank Sample Model
The Baby Bank model consists of the following:






Five dimensions
1. Channel (3 members: ATM, branch, and call center)
2. Customer (101 members: 50 individuals and 51 businesses)
3. Customer type (4 members: corporate banking, private banking, retail consumer
banking, and small business banking)
4. Product (14 members: credit products, credit-unsecured, credit-secured, deposit
products, term, savings, recurring, checking, fee-based products, other products,
revolving credit products, overdrafts, credit cards, and third-party products)
5. Regions (204 members: by area, country, state, and city)
Two periods (three levels each: year, quarter, and scenario)
1. 2006_q4_actual
2. 2006_q4_budget
Six transaction tables with a total of 4,180 records
ABMCost:
1. Load_Trans_q4a
2. Load_Trans_q4b
CallCenter:
3. CallCenter_q4a
4. CallCenter_q4b
Revenue:
5. Revenue_q4a
6. Revenue_q4b

6
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Profitability Management Goals
Baby Bank is constantly growing its customer base. They have been very effective
with their new marketing campaign. But it has not been growing in profitability, so the
previous goals for increasing revenue as the primary goal for Baby Bank are being reevaluated. The new focus for Baby Bank is on controlled profitable growth. So the
profitability of all customers will be evaluated on a detailed basis. Once Baby Bank can
determine what are the characteristics of profitable customers, internal controls can be
implemented to decrease the costs associated with high cost activities. The ultimate goal
is to move existing customers to profitability through behavior changes or increased
fees. Recruiting more profitable new customers will be keyed on marketing efforts to
target new customers with behaviors that will be profitable to Baby Bank.

Source Behaviors Model Structure
In the Baby Bank example model, the source content for the behaviors came from an
activity-based costing model. This ABC model started with general ledger expenses and
assigned the costs to activities based upon staff efforts required and capital employed.
Then the activities were traced to cost objects by channel (ATM, branch, call center), by
product supported (savings, checking, mortgage), and by transaction type (open account,
check balance, make deposit). These cost objects from ABM by channel, product, and
transaction type are the source behaviors feeding into the SAS Profitability
Management model.
In implementing SAS Profitability Management, behavior costs can come from any
source. ABC is not a required source for SAS Profitability Management. As long as the
appropriate costs are traced for each behavior at an appropriate level of granularity and
an appropriate cost basis unit or total has been reliably calculated, it will be a good
source feed for behaviors into SAS Profitability Management.

Transaction Data Collection
Operational transaction data tracing customer interactions with the company are
critical to the effectiveness of the SAS Profitability Management model. This transaction
detail can come from a multitude of source systems within your corporation. For the
Baby Bank model. there are three sources for the transactional costs. The first is the
transaction register for all interactions on an account basis (ATM and branch
transactions). The second is a register for all call center interactions on a customer and
product basis. The third source system is a register for all customer revenue tracing fees
for credit cards and interest payments.

Basic Steps for Building the Model
Using SAS Profitabillty Management involves the following tasks:
1. Populate the input directory

The Baby Bank Model

2.
3.
4.
5.
6.
7.
8.

Set up the environment
Create a new profitability model
Define transaction table groups
Define rules and associate them with behaviors
Calculate the model
Prepare reports
View the reports

Basic Steps for Building the Model
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Retrieve the Tutorial Data
The sample SAS tables for this tutorial are on the CD as part of the middle-tier install
files. Follow the instructions in the SAS Profitability Management 1.3 Installation
Instructions to install the tutorial data on a machine that your workspace has access to.
The following files are provided on the installation CD for use with this tutorial:

association.sas7bdat

Holds the relationships between the behaviors (where
costs reside) and the rules (which define the
assignment logic to transactions).

behavior.sas7bdat

Holds all of the transactions and costs (total or unit)

callcenter_q4a.sas7bdat

Call center transaction details for the 4th quarter
actual

callcenter_q4b.sas7bdat

Call center transaction details for the 4th quarter
budget

dim_channel.sas7bdat

Hierarchy definition for the channel dimension

dim__customer.sas7bdat

Hierarchy definition for the customer dimension

dim__custtype.sas7bdat

Hierarchy definition for the customer type dimension

dim__period.sas7bdat

Hierarchy definition for the time period dimension

dim__product.sas7bdat

Hierarchy definition for the product dimension

dim__region.sas7bdat

Hierarchy definition for the region dimension

load_trans_q4a.sas7bdat

ABMCost transaction details 4th quarter actual

load_trans_q4b.sas7bdat

ABMCost transaction details 4th quarter budget

reportHierarchy.sas7bdat

Report hierarchy defining the drill-down detail

reportLayout.sas7bdat

Report layout defining the profit and loss calculations

revenue_q4a.sas7bdat

Revenue transaction details 4th quarter actual

revenue_q4b.sas7bdat

Revenue transaction details 4th quarter budget

rules.sas7bdat

Definition of the assignment rules logic

For additional details describing the source tables required for SAS Profitability
Management, please refer to “Summary of Model Files” on page 105.

10 Create an Output Directory
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Create and Populate the Input Directory
You must create a directory on your SAS Profitability Management server to hold the
source files for the tutorial. These are the files that you just extracted from tutorial.zip.
1

Create a directory on the SAS Profitability Management server.
You can place the directory where you like and name it what you like. For
purposes of illustration, we assume that you create and name it as follows:
C:\SAS\ProfitabilityManagement\Bank_In

2

Give yourself (or whoever is doing the tutorial) read, modify, and write acess to
the directory. If you have an access problem in doing the tutorial, that this
permission has probably not been granted.

3

Copy the files from your local machine to the directory that you just created on the
SAS Profitability Management server.

Create an Output Directory
You must also create a directory on your SAS Profitability Management server to hold
the calculated transaction tables. This is where SAS OLAP cube generation gets its
source content for generating cubes. Do not put anything into the output directory.
1

Create a directory on the SAS Profitability Management server.
You can place the directory where you like and name it what you like. For
purposes of illustration, we assume that you create and name it as follows:
C:\SAS\ProfitabilityManagement\Bank_Out

2

Give yourself (or whoever is doing the tutorial) read, modify, and write acess to
the directory. If you have an access problem in doing the tutorial, this permission
has probably not been granted.
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Add Users
Before anyone can begin using SAS Profitability Management, you must use the SAS
Management Console as an administrator to add a Profitability Management user
account.
1

Log on to the SAS Management Console as an administrator.

2

Select the Foundation repository.

3

Select Environment Management.

4

Right-click User Manager, and select New > User.

5

Name the new user, and enter other user information on the General tab.

6

Click the Groups tab, and add PM Users to the list of groups that the user is a
member of.

12 Add Users

Chapter 4

7

8

Click the Logins tab, and then click New.
•

Enter the new user’s User ID, including domain, on the network.

•

Leave the Password field blank (it comes from the Profitability Management
logon).

•

Leave the Confirm Password field blank (it comes from the Profitability
Management logon).

•

Select DefaultAuth for the authentication domain.

Leave the Authorization tab blank.

Set Up the Environment

9
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Click OK.

The user is created. You can log off the SAS Management Console as administrator.

Identify Input and Output Directories to Profitability Management
Having created an input and output directory on the server, you must let SAS
Profitability Management know where they are located. To do so, you use the SAS
Management Console:
1

Log on to the SAS Management Console with the user account that you just
created.

2

Select the Foundation repository.

3

Expand Data Library Manager.

4

Right-click SAS Libraries.

5

Click New Library.

6

Select SAS Base Engine Library as the type of library to be created, and then
click Next.

7

Name the library Bank_In, and then click Next.
You can give the library any name you want (eight characters maximum). For
convience, we give it the same name as the directory.

14 Identify Input and Output Directories to Profitability Management
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8

Type Bank_In as the Libref name. For convenience, again, we use the name of the
directory.

9

Specify BASE as the engine type.

10 Specify the library directory path, and then click Next.
Note: If the path does not exist to be selected in the list-box of available paths,
then click New to create the path.
The directory can be anywhere on the server, but we have assumed that you
created it at: C:\SAS\ProfitabilityManagement\Bank_In.

Set Up the Environment
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11 Click Next, and then click Finish.
12 Click View > Refresh from the menu bar to see the library listed.
Repeat this process for the output library. Be sure to give it a different name and
libref, such as Bank_Out, and specify a different directory path – where your output
directory is located.
Note: You can choose to save the output tables in a database rather than in SAS data
sets. For information, see the following section.

Saving Output Tables in a Database
If you want to save your output tables in a database library, then do the following to
create your output library:
1

Log on to the SAS Management Console with the user account that you just
created.

2

Select the Foundation repository.

3

Expand Data Library Manager.

4

Right-click SAS Libraries.

5

Click New Library.

6

Select among the Database Libraries for the type of library to be created, and then
click Next.

16 Identify Input and Output Directories to Profitability Management
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The following table shows the appropriate choices of Database Library for each of
the possible types of database.
Database

Appropriate Database Library

DB2

DB2 Library for Unix and PC Hosts
DB2 Library for z/OS Hosts

Microsoft SQL Server

ODBC Library (Windows)
OLE DB Library (Windows)
Microsoft SQL Server Library for Unix Hosts

7

MySql

MySQL Library

Oracle

Oracle Library

MS Access

OLE DB Library (Windows)

Name the library, and then click Next.
You can give the library any name you want (eight characters maximum).

8

Type a Libref name, and then click Next.

9

Specify the Database Server and Login information, and then click Next.

10 Optionally, select the SAS server where this library is to be assigned, and then
click Next.
11 Review the library information, and then click Finish.
12 Click View > Refresh from the menu bar to see the library listed.
13 Right-click the newly created library and select Properties.
The Properties window opens.
14 Select the Extended Attributes tab.
15 Click New.
16 In the Field Name column, type DBMSType.

Set Up the Environment
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17 In the Value and Description columns, type one of the following pairs depending
upon your database (the Description is optional).
Value

Description

MSSQL

Microsoft SQL Server

Oracle

Oracle

DB2

DB2

MySql

MySql

Jet

MS Access

For example, as shown in the following graphic:

Import Tables into the Input Directory
Even though you used the operating system to copy source files into the input
directory, SAS does not yet know about them. Use the SAS Management Console to
store metadata regarding the files by importing them (only structural metadata is
imported, and not the actual content of the files).
Note: If you modify the input tables, you must reimport them so that the metadata
that is maintained by SAS Management Console is updated (column names and data
types).
1

Log on to the SAS Management Console with the user account that you just
created.

2

Select the Foundation repository.

3

Expand Data Library Manager.

4

Expand SAS Libraries.

5

Select the input library, Bank_In.

18 Import Tables into the Input Directory
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Select Actions > Import Tables.
The Connect to SAS window opens.

7

Select SASMain as the SAS server, and click Next to log on to SASMain.

8

Verify that the input library is correct, and then click Next.

Set Up the Environment

9
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Select the tables to be imported, and then click Next.

10 View the summary of which tables are to be imported, and then click Finish.
After the tables have been imported, the SAS library should look like the following:

20 Import Tables into the Input Directory
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Introduction
Creating a new profitability model involves the following steps:
1

Naming the model and identifying its time dimension

2

Specifying libraries for model output

3

Verifying the location for the model definition

4

Identifying the behavior table for the model

5

Identifying custom dimension tables for the model

6

Identifying the report hierarchy and report layout tables

Open the Profitability Management Client Application
Open the SAS Profitability Management rich client application.

22 Open the Profitability Management Client Application
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1

Specify the user ID and password that you created in the SAS Management
Console.

2

Specify the SAS Profitability Management server. This is dependent on your
installation.

3

Specify the port. 8561 is the default for the the SAS Metadata Server.

4

Click Log On.

The SAS Profitability Management rich client application opens.

Create a New Profitability Model
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Open the Model Wizard
1

Select File > Organize Models (or click the Organize Models icon).

2

Click New Model.

The Model wizard opens.
Note: If this is the first time that the SAS Profitability Management client has ever
been invoked, the Model wizard opens automatically.

Name the Model and Select the Time Dimension
1

Name the model, for example Baby Bank.

2

Click Select to select the time dimension table.

3

Select DIM_PERIOD as the time dimension table.
We are assuming that the library in which you placed the input files is named
Bank_In.

24 Select the Output Libraries
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Click OK.
The time dimension table defines the time periods in the model. The number of
periods in a model varies with the reporting needs of a business. The sample time
dimension table, DIM_PERIOD, is shown in the following graphic (you can click
the Preview button in the Model wizard to see the table).

5

Click Next.

Select the Output Libraries
1

Specify the Analysis view name.
The analysis view name is used as the name of the database view that is created
to join the transaction output tables into a single virtual fact table that the OLAP
cube is built from. By default, the analysis view name is the same as the model
name.

2

Specify the Analysis view library.
For this tutorial, we have created a single output directory, Bank_Out. You can
select this directory to store the analysis view in.
Note: The Analysis view library must be a SAS Base Engine Library.

3

Select the Output table library.

Create a New Profitability Model
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While it can be helpful to have separate directories to hold the analysis view and
calculated transaction tables, for this tutorial we have created a single output
directory, Bank_Out.
Note: The output table library can be either a SAS Base Engine Library or a
Database Library. If it is a Database Libary, then it must be separate from the
Analysis View Library, which is required to be a SAS Base Engine Library. For
information on using a Database Library, see “Saving Output Tables in a
Database” on page 15.
Assuming, for this tutorial, that you choose the same directory to hold all your
tutorial output, the page appears as follows:

4

Click Next.

Verify the Data Locations for the Model
1

Verify the Server folder where data associated with the model is stored.

2

Verify the Metadata folder where model metadata is stored.
Note: Both storage locations were established during installation. Do not change
them now. At this point, the dialog box is informational only.

3

Click Next.

26 Select the Behavior Table
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Select the Behavior Table
1

Click Select to select the behavior table for the model.

2

Select BEHAVIOR from the available tables.

3

Click OK.

4

Identify fields in the behavior table.
A behavior table must contain a field for each of the following: ID, Name, Unit
Value, Total Value, and Period. You must identify which field is which in the table
selected.
By default, SAS Profitability Management assumes that these fields are named as
follows: “ID”, “Name”, “UnitValue”, “TotalValue”, and “Time”. If fields with those
names exist in the behavior table, then they are automatically mapped. If the
fields are named differently, then you must match them manually.
The sample behavior table, BEHAVIOR, contains these fields, so they are mapped
automatically.

Create a New Profitability Model
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Click Next.

What is a Behavior Table?
Behaviors, typically, are things that your customers do. For example, the customers
of a bank can check their balance, make deposits, transfer funds, and make
withdrawals.
The following graphic shows part of the sample behavior table, BEHAVIOR. Notice
the following:


Each behavior (each row of the behavior table) has either a non-zero UnitValue, or
a non-zero TotalValue, but not both.



The table contains an extra column named “AssignmentRule”. All of your source
tables can have extra columns. This particular field is an extra column containing
a character string that is used in filtering the table to select a subset of behaviors.

28 Identify Dimension Tables
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Identify Dimension Tables
1

Click Add to select the custom dimension tables that make up the cube.

2

Select the following dimension tables, and click Add:
DIM_CHANNEL
DIM_CUSTOMER
DIM_CUSTYPE
DIM_PRODUCT
DIM_REGION
Note: You can select multiple dimensions by using the Shift or Ctrl key.

3

Click OK.

Create a New Profitability Model

Add Report Tables 29

The dimension tables are added to the model as shown in the following graphic.

4

Click Next.

Add Report Tables
1

Click Select for the Report hierarchy, and select REPORTHIERARCHY.

2

Click Select for the Report layout, and select REPORTLAYOUT.

30 Add Report Tables
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3

Click Finish, and verify that the new model, Baby Bank, is added to the list of
models.
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Define Transaction Table Groups
Transaction tables that share the same column structure are organized into table
groups. A single Profitability Management model is likely to have multiple table groups.
Multiple rules likely use the same source table group.
Note: There is one transaction table for each period in a model.
For the Baby Bank model, you define three transaction table groups:


ABMCost holds the transaction costs that relate to the ATM activities and the
detailed branch activities.



CallCenter holds the details of the activities performed at the call center.



Revenue holds the detailed revenue for all of the customers noted.

Enter these table group names exactly because they must match the names in a predefined rules definition table.

Define the ABMCost Group
Defining transaction table groups is a two-part process:


Define the transaction table group.



Add transaction tables to the group (and associate each transaction table with a
time period).

32 Define the ABMCost Group
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Define the Transaction Table Group
1

Select the Transaction workspace.
Make sure that the Baby Bank model is selected.

2

Click Add table group (or the Add table group icon

).

The Add Table Group window opens.
3

Name the group ABMCost, and then click Next.

4

Select LOAD_TRANS_Q4A as the table whose schema serves as the schema for
the table group.

Define Transaction Table Groups
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Note: All the tables in a table group share the same schema, and each table is
associated with a different time period.
5

Click Next.

6

Specify whether each column in the table is


Text



Numeric



Dimension member (if a dimension member, specify which one).

The specifications for LOAD_TRANS_Q4A should look like those in the following
graphic:

7

Click Finish.
The table group, ABMCost, is added to the list.

34 Define the ABMCost Group
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Add Tables to the Group
1

Click Add transaction tables (making sure that ABMCost is selected).

Or click the icon.
The Add Transaction Tables window opens.
2

Select LOAD_TRANS_Q4A and LOAD_TRANS_Q4B.

3

Click Add.
The tables are added.

Define Transaction Table Groups

4

Click Next.
The Period window opens.

5

6

Associate each of the tables with a period as follows:
Table

Period

LOAD_TRANS_Q4A

Actual > 2006 > 2006_Q4

LOAD_TRANS_Q4B

Budget > 2006 > 2006_Q4

Click Finish.
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The tables are added to the group.

Transaction Table LOAD_TRANS_Q4A
The following graphic shows the transaction table, LOAD_TRANS_Q4A, and how
each of its columns is identified as either text, numeric, or a dimension member. You can
see that each column that is identified as a dimension member contains values that
correspond to values in the ID field of the corresponding dimension table.

Define Transaction Table Groups
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Define the CallCenter Group
Repeat the same general process to define a transaction table group named
CallCenter:


Define the transaction table group



Add transaction tables to the group (and associate each transaction table with a
time period).

Define the Transaction Table Group
1

Select the Transaction workspace.

2

Click Add table group.

3

Name the group CallCenter, and then click Next.

38 Define the CallCenter Group
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4

Select CALLCENTER_Q4A as the table whose schema serves as the schema for
the table group.

5

Click Next.

6

Specify whether each column in the table is text, numeric, or a dimension member
as shown in the following graphic, and then click Finish.
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The table group, CallCenter, is added to the list.

Add Tables to the Group
1

Click Add transaction tables (making sure that CallCenter is selected).

2

Add CALLCENTER_Q4A and CALLCENTER_Q4B to the list, and then click
Next.
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3

Associate each of the tables with a period as shown:

4

Click Finish.
The tables are added to the group.
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Transaction Table CALLCENTER_Q4A
The following graphic shows a portion of the contents of the transaction table
CALLCENTER_Q4A.

42 Define the Revenue Group
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Define the Revenue Group
Repeat the same general process to define a transaction table group named Revenue.

Define the Transaction Table Group
1

Click Add table group.

2

Name the group Revenue, and then click Next.

3

Select REVENUE_Q4A as the table whose schema serves as the schema for the
table group.

4

Click Next.

5

Specify whether each column in the table is text, numeric, or a dimension member
as shown in the following graphic, and then click Finish.
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The table group, Revenue, is added to the list.

Add Tables to the Group
1

Click Add transaction tables (making sure that Revenue is selected).

2

Add REVENUE_Q4A and REVENUE_Q4B to the list, and then click Next.
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3

Associate each of the tables with a period as shown:

4

Click Finish.
The tables are added to the group.
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Transaction Table REVENUE_Q4A
The following graphic shows a portion of the contents of the transaction table
REVENUE_Q4A.

46 Define the Revenue Group
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Overview
Analysis settings control the formatting of numbers in cube reports. The value field is
particularly critical to be correctly formatted. The value field displays revenue and cost
in the profit and loss reporting on the web.
1

Select Edit > Analysis Settings.
The Analysis Settings window opens.

Select Periods for the Cube
1

Check Include transaction tables from all periods.
The view is created with a join across all available calculated transaction tables.

48 Select Formats for Numeric Measures
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The selected periods are included in the view that is used as the source for the OLAP
cubes and, thus, the reporting.
If you want the cubes and reporting produced to include only a selected set of periods,
use this dialog box to select the periods and, thus, define the table joins in the view.
Each transaction table represents a single period. These calculated transaction tables
are stored in the output table library. The cubes represent results across multiple
periods, but the cubes do not need to include every calculated period.
Note: The periods that you select for inclusion in a cube must also be chosen for
calculation when you calculate the model. Unless a period has been calculated, it cannot
be included in a cube.

Select Formats for Numeric Measures
1

Click the Measures tab.
The Measures tab lists all numeric properties available to the model. All
numerical properties are available to be included in profit and loss reporting. This
includes:

2



all entered numeric properties from the transaction tables



all the calculated properties:
• Quantity – a numeric value based upon the rules driver formula
• Value – the calculated behavior amounts (revenue or cost)

For the VALUE measure, specify DOLLAR5.2.
Value is the calculated cost or revenue for a transaction. The method of its
calculation depends upon whether the behavior table row that is accessed by an
assignment rule contains a unit value or a total value. See “Calculation – a
Conceptual View” on page 76.
Default number formats are all 8.2 (eight characters with two of them after the
decimal).

Change Analysis Settings
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The following SAS formats are available:

BESTw

Best available format with width=w

COMMAw.d

Comma and decimal points with width=w and decimal=d

COMMAXw.d

Comma and decimal points with width=w and decimal=d (switches
the role of comma and decimal points)

DOLLARw.d

Dollar signs, comma, and decimal points with width=w and
decimal=d

DOLLARXw.d

Dollar signs, comma, and decimal points with width=w and
decimal=d (switches the role of comma and decimal points)

EUROw.d

Euro signs, comma, and decimal points with width=w and decimal=d

EUROXw.d

Euro signs, comma, and decimal points with width=w and decimal=d
(switches the role of comma and decimal points)

PERCENTw.d

Percentage with width=w and decimal=d and a percentage sign

Zw.d

Prefixed with zero to get width=w and decimal=d

w.d

width=w and decimal=d
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Introduction
An assignment rule associates rows in a transaction table with a behavior. An
assignment rule:


is associated with one or more rows in a behavior table



specifies which rows in a transaction table group to include in a calculation



specifies what quantity to include in the calculation.

An assignment rule is implicitly associated with a single transaction table in a table
group — namely, the transaction table whose period is specified in the behavior table
row with which the rule is associated.

Define the First Rule
1

Click the Rules workspace.

2

Select ABMCost as the table group to use the rule.

3

Click Add assignment rule.

52 Define the First Rule
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The Add Rule window opens.
4

Name the rule ATM_CHK_Check balance.

5

Click Define.

The Selection Criteria window opens.
6

Select AssignmentRule from the drop-down list of column names to select.

7

Select “=” from the drop-down list of operators.

8

Click Select, and select ATM_CHK_Check balance from the dialog box of
possible text strings.
The dialog box shows all the possible text strings in the AssignmentRule column of
the ABMCost table group. (Remember that you selected ABMCost as the table
group to which this rule applies.)
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After making your selections, the Selection Criteria window should look like the
following:

9

Click OK.
You return to the Add Assignment Rule window.

10 Select AMT from the drop-down list of values for the driver formula.
The formula uses the value of the AMT column to calculate a value for every row
picked out by the selection criterion:
AssignmentRule =’ATM_CHK_Check balance’
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AMT represents the number of times a transaction (such as checking one’s
balance) occurred.
Count holds a value of 1 for every transaction. If you need to know, for example,
how many customers used a specific product, you can filter by product and use the
Count property to calculate.
11 Click OK.
The rule is added to the list of rules for the table group ABMCost.
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How Rules Work
An assignment rule associates rows in a transaction table with a behavior. An
assignment rule:


is associated with one or more rows in a behavior table



includes selection criteria that specify which rows in a transaction table group to
include in a calculation



includes a driver formula that specifies what quantity to include in the
calculation.

An assignment rule is implicitly associated with a single transaction table in a table
group — namely, the transaction table whose period is specified in the behavior table
row with which the rule is associated.

Define Another Rule
1

Make sure you are in the Rules workspace.

2

Make sure that ABMCost is selected as the table group to use the rule.

3

Click Add assignment rule.
The Add Rule window opens.
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4

Name the rule ATM_OTP_Manage Transactions.

5

Click Define.

The Selection Criteria window opens.
6

Select the dimension Channel from the drop-down list of column names to select.

7

Select “is child of” from the drop-down list of operators.
The ‘child of” operator is hierarchically driven. By selecting a member of a
dimension at a point in the hierarchy, you are actually including that specific
member and all of its children in the dimensional hierarchy.

8

Click Select, and select [ATM] from the dialog box of possible values.

After making your selections, the Selection Criteria window should look like the
following:

9

Click Add New Row.

10 Select the dimension Product as the column to filter on.
11 Select “is child of” from the drop-down list of operators.
12 Select Other Products from the dialog of possible values.
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13 Click OK.
You return to the Add Assignment Rule window.
14 Select Count from the drop-down list of values for the driver formula.
The formula uses the value of the Count column in calculating a value for every
row picked out by the selection criteria.

15 Click OK.
The rule is added to the list of rules for the table group ABMCost.
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Import the Remaining Rules
Instead of defining rules one by one, you can put the rule definitions in a file and
import the file into SAS Profitability Management.
1

Click Import assignment rules.
The Import Rules window opens.

2

Click Select, and select RULES as the table to import.

3

Identify fields in the rules table.
A rules import table must contain a field for each of the following: Name, Selection
Criteria, Driver Formula, and Table Group Name.
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Import the Remaining Rules 59

By default, SAS Profitability Management assumes that these fields are named as
follows: “AssignmentRule”, “SelectionCriteria”, “DriverFormula”, and
“TableGroup”. If fields with those names exist in the rules table, then they are
automatically mapped. If the fields are named differently, then you must match
them up manually.
The sample rules table, RULES, contains these fields, so they are mapped
automatically.

4

Click OK.
The rules are imported.
Note: It is considered an error if a rule already exists. It is not overwritten.
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Import Table for Rules
The following is a portion of the import table – RULES. Notice that it contains rules
operating upon all three table groups in the Baby Bank model – ABMCost, CallCenter,
and Revenue. It is not necessary to create a separate table of rules for each table group.

Associate Behaviors With Rules
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Associate Behaviors With Rules
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Associate Behaviors with Rules
Each behavior must be associated with only one rule. Multiple behaviors can be
associated with the same rule.
1

Click the Behaviors workspace.

2

Select the behavior 20003 ATM_CHK_Check balance.

3

Click Create a new association.

The Associate Rules window opens.
4

Select the ABMCost table group – the table group to which the rule is applied.

5

Make sure that the behavior ABM_CHK_Check balance is selected.

6

Select the rule ABM_CHK_Check balance.

7

Click Associate.

8

Click OK.
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The rule is associated with the behavior, as shown in the behaviors workspace.

Import the Remaining Associations
1

Click Import associations.
The Import Associations window opens.

2

Click Select.
The Select Table dialog opens.

3

Select the ASSOCIATIONS table to import.

Associate Behaviors With Rules

4

Click OK.

5

Identify fields in the ASSOCIATIONS table.
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A rules association table must contain a field for each of the following: Behavior
Id, Table Group Name, and Rule Name.
By default, SAS Profitability Management assumes that these fields are named as
follows: “BehaviorId”, “TableGroup”, and “AssignmentRule”. If fields with those
names exist in the associations table, then they are automatically mapped. If the
fields are named differently, then you must match them up manually.
The sample table, ASSOCIATIONS, contains these fields, so they are mapped
automatically.

6

Click OK.
The behaviors are associated with rules.
Note: If a behavior is already associated with a rule, an error message is issued
and the association is not replaced.
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Prepare Reports

Define a Summary Report 65
Define a Detail Report 68

Define a Summary Report
A summary report in SAS Profitability Management represents an OLAP cube. In
defining a summary report, you define the attributes of a cube.
1

Select the Reports tab.

2

Click New summary report definition.

The New Summary Report Definition window opens.
3

Name the report, for example Baby Bank, and click Next.

66 Define a Summary Report

4

Chapter 10

Select the dimensions and dimension levels to be included in the report.


Select L3_Quarter for the DIM_PERIOD dimension.



Select L5_Profit for the REPORTHIERARCHY dimension.

For each dimension to be included in the summary cube, specify the level of drilldown allowed.
The default drill-down depth is always the top of the dimension. In this case the
top of the time dimension is 2006. If no additional drill-down was selected, the
summary report would hold totaled values for 2006, with no additional detail
available to drill down.
You can select to include any level of depth defined in your dimensional hierarchy
to include in your report.
All decisions on the number of dimensions and the depth of drill-down in any
selected dimension have a dramatic impact on the reporting performance. It is
wise to limit summary reports to specific areas where business decisions will be
made.

Prepare Reports
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It is also wise to produce lots of individual summary reports meeting specific
managers’ needs focused upon specific dimensions rather than creating an allencompassing summary report that has all dimensions and all drill-down levels.
5

Click Next.

6

Select VALUE as a measure to be included in the report.
The VALUE property is the default. It is the calculated cost for a transaction.

All numeric properties are available for inclusion in a summary report. The
following are available:




7

Source table transactions numeric properties, by source table group:
• ABMCost (AMT, Count)
• CallCenter (communication, complaints, count, crossSell, inquiry, offer,
requests)
• Revenue (AMT)
Calculated results
• Quantity – the result of the rules driver formula noted on each row of the
transaction tables based on behaviors.
• Value – the calculated result for the behavior source (revenue and costs)
applied to the transaction details based on the rules defined. The method of
its calculation depends upon whether the behavior table row that is
accessed by an assignment rule contains a unit value or a total value, as we
shall see in greater length in “Calculation – a Conceptual View” on page 76.

Click Finish.
The report definition is added.

68 Define a Detail Report
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Define a Detail Report
Detail reports produce a report based on a single dimension and by filtering a single
value in that dimension. Detail reports are run from the SAS Profitability Management
Web Client and create a cube on the fly.
1

Click the Detail Reports tab.

2

Click New detail report definition.

The New Detail Report Definition window opens.
3

Select CustID as the column to be featured in the detail report, and then click
Next.
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When defining a detail report, you should choose the dimension that will most
uniquely filter the result. A detail report results in a cube created on the fly.
Selection logic is processed to filter the starting transactional content to the single
customer selected.
The goal for quick reporting response time is to try to filter your result such that
the selected answer has fewer than 1,000 records. So, while there are other
dimensions in the model, it would be unwise to select any dimension other than
customer, because the filtered results would be more than 1,000 records.
4

Click Next.

5

Select the dimensions and dimension levels to be included in the report.


Select L3_Quarter for the DIM_PERIOD dimension.



Select L5_Profit for the REPORTHIERARCHY dimension.
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6

Click Next.

7

Select VALUE as a measure to be included in the report.
The VALUE property is the default. It is the calculated cost for a transaction.

All of the numeric properties are available to be included in a report.
8

Click Finish.
The system processes all of the calculated transaction tables and adds an index for
the dimension you have selected for detailed reporting. The SAS log notes that a
simple index has been created. A dialog box displays the results.
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And, the report definition is added to the list of available detail reports. The list of
detail reports is the same list that will be available in the Web Report client.
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Calculate the Model
1

Select Actions > Calculate Model.
The Calculate window opens.

2

Select both periods to be calculated for the model, and then click Next.

Each transaction table represents a single period. When you are calculating a
model, you do not need to recalculate all of the transaction tables. This is ideal for
calculations for incremental periods. You can calculate January, for example, and
then calculate February as a separate calculation. You never need to process a
single period’s transactions more than once as the months proceed through the
year.
The summary reports and detail reports reflect transaction tables for time periods
that have been calculated and that have been selected for cube inclusion in the
analysis settings (see “Select Periods for the Cube” on page 47). So the generated
cubes contain the complete details for calculated transaction tables across periods.
3

Select all three table groups to be calculated for the model, and then click Next.
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4

Select the cubes (summary reports) to be generated and then click Next.
The window shows Baby Bank, which is the name you assigned to your summary
report.

5

Select the number of concurrent sessions, and then click Finish.
SAS Profitability Management can start concurrent sessions to distribute the
workload across multiple CPUs. One transaction is allocated to each session.
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When the calculation and cube generation completes, you can view the SAS log.

6

Select File > Exit to close the application.
You are now finished working with the SAS Profitability Management rich client.

7

Verify the calculation process by reviewing the files created on the server.
Calculation result tables are stored in the directory where you defined the target
destination LIBNAME. If you remember, we assumed that you created a directory
on the server for this purpose named
C:\SAS\ProfitabilityManagement\Bank_Out.
Log on to the server and view the output files. In addition to creating the
calculated transaction tables, the generation process creates
babybank.sas7bvew. The analysis view name is used as the name of the
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database view that is created to join the transaction output tables into a single
virtual fact table that the OLAP cube is built from.

Calculation – a Conceptual View
The following graphic shows a sample transaction table before and after a calculation.
The calculation has added three new columns to the transaction table in the output
directory:
Driver Quantity
is the number of units calculated by the driver formula. The calculation is based on
whether the behavior-table row that is accessed by an assignment rule contains a unit
value or a total value.
Calculated Value
is the calculated cost for a transaction. The method of its calculation depends upon
whether the behavior table row that is accessed by an assignment rule contains a unit
value or a total value.
Behavior
is the ID of the row from the Behavior table that is used in the calculation for a
transaction.
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Calculation Using a Unit Value
When a behavior table row contains a unit value, the driver formula calculates the
number of units that are involved in each transaction that is picked out by the selection
criteria. The number of units appears in the DriverQty field. Then, the cost for that
transaction (Value) is determined by multiplying the number of units (driver quantity)
by the unit cost (in the behavior table) of the transaction.
The following graphic shows a conceptual example of a calculation using a unit value
from the behavior table.
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Calculation Using a Total Value
When a behavior table row contains a total value, the driver formula is used to
calculate the number of units involved in each transaction that is picked out by the
selection criteria. Then, the cost for that transaction is determined in the following way:
1

The total number of units for all transactions (picked out by the selection
criteria) is calculated by adding the number of units (as determined by the driver
formula) for all the transactions picked out by the selection criteria.

2

The cost per unit is calculated by dividing the total value (in the behavior table
row) by the total number of units.

3

The cost for each transaction (Value) is calculated by multiplying the cost per
unit times the number of units (as determined by the driver formula) for that
transaction.

The following graphic shows a conceptual example of a calculation using a total value
from the behavior table.
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Output Tables Grow in Length
Something important to understand about calculation is that the number of rows in
the calculated transaction table will generally increase. It will increase when multiple
rules access the same rows in the input transaction table. In that case, an additional
row is created in the output table each time a new rule accesses the same row in the
input table. For example, the following graphic shows the second rule
(ATM_CHK_Requests) picking out the same three rows in the input table as the first
rule (ATM_CHK_Check balance). The second rule, therefore, adds three more rows to
the output table – in addition to the three rows added by the first rule.
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View the Summary Report
After using the SAS Profitability Mangement rich client to calculate a model and
generate reports, you use the SAS Profitability Management Web Report client to view
the reports. Anyone with a browser and access to the Web can view the reports –
provided, of course, that they have permission.

Open the Baby Bank Report
1

Log onto the SAS Web Report client.
Access it with the URL: http://<<your web server>>:8080/SASProfitability/.

The user name and password are what you defined earlier using the SAS
Management Console – the same user name you have used up to now in accessing
the SAS Profitability Management rich client.
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The SAS Web Report client opens at the Summary Report tab.
2

Select the Baby Bank model and click the Baby Bank cube.

The Baby Bank summary report opens in the SAS Web OLAP viewer.
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The profit and loss statement is displayed in table format. By default, the display
shows:


Rows: determined by the combination of the report layout table and the report
hierarchy table.



Columns: the time period dimension.



Slicer: the Value property as calculated by the application of rules to the
transaction tables.

See More Columns of Data
See more detail in the time dimension by expanding the columns.
1

Click the plus sign next to Actual to expand the column.

2

Click the plus sign next to 2006 to expand the year.

You should see a column for actual and a column for budget, as shown in the
following graphic.
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Note: You can click the plus sign to expand, or click the down-arrow to drill down.



Drilling down replaces the current header with the next lower-level header.



Expanding shows the next lower-level header, and leaves the current header
in place.

After expanding or drilling down, you can navigate in the opposite direction
(collapsing or drilling up) by clicking in the approprate place.

See More Rows of Data
1

Click the arrow at the bottom of the table to scroll to the last row of the table.

V iew the Reports

2
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Click the plus sign next to Sales and Marketing Effort to expand the row.

Click the plus sign next to Cost to Retain to expand it.

3

Continue clicking the plus sign to fully expand that branch of the Sales and
Marketing Effort. Your display should look like the following:
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The levels available to drill to additional detail in the cube depend upon the number
of dimension levels in the dimension hierarchy and the number of dimension levels that
you select in the definition of the summary cube. This is explained further in “Report
Hierarchy” and “Report Layout” starting on page 121.

Customize the View
You can remove blank content from the report with the Preferences dialog box.
1

Click Preferences (near the top of the window).

The Preferences dialog box opens.
2

Select two columns for the layout.

3

Check Suppress empty data.

V iew the Reports
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Click OK.

Filter Data
You can select specific values to display using a filter.
1

Click the Filter icon on the tool bar.

2

Select REPORTHIERARCHY to filter the report by its rows, and then click Edit
to pick the rows.

3

Select the rows as shown in the following graphic (you will have to scroll to select
them all).
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After you click OK, the filter expression shows that you have set a filter on the
REPORTHIERARCHYSet.

4

Click OK, and the report is filtered to show only the rows you have selected.
Notice that the top of the report shows what filter is applied.

V iew the Reports
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Clear the filter by doing the following:
a. Click the Filter icon.
b. Select REPORTHIERARCHYSet.
c. Click Clear.
d. Click OK.
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Change the Appearance
1

Click Properties.

The Properties dialog box opens.
2

Select the following properties, and then click OK.


Select All rows to display on the page.



Select All columns to display on the page.



Select a Column Heading Color.



Select Show color gradients in row and column headings to indicate
depth of drilling with colors.

The appearance of the report changes accordingly.
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Format Numbers
The default format for the numbers can be directly defined in the SAS Profitability
Management rich client. You have already edited analysis settings to select the format
DOLLAR15.2. If you want to create an additional custom format for your numbers in
the SAS Web OLAP viewer (maybe to display values in thousands), you need to create a
new calculated measure and apply a custom format to that measure.
1

Click the Calculate New Measure icon on the tool bar.

The Calculate New Measure dialog box opens.
2

Name the new measure Thou.

3

Assign the following calculation expression for the measure:
<<root.VALUE>>/1000.

4

Click Select Format.
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The Format dialog box opens.
5

Select Numeric as the format type.

6

Select DOLLAR.

7

Click OK.
The format is added to the Calculate New Measure dialog box.
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Click Add, and then click OK.
The Thou measure is automatically added to the columns of numbers displayed, as
you can see in the following graphic.

If you want only the Thou column to display, then do the following:
9

Select VALUE from the Selected items panel.

10 Click Remove.
11 Click Apply.
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Only the value in thousands is displayed.

Add a Bar Chart to the Report
You can add bar charts and other graphs to your report. To illustrate this, let’s first
start over with a fresh view of the summary report.
1

Click Profitability Management at the top of the window to start over.

The list of available summary reports appears.

V iew the Reports
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Click Baby Bank.

The Baby Bank cube opens.
3

Click the Bar Chart icon on the tool bar.

A bar chart is added to the bottom of your report.

Customize the Bar Chart
1

Click Properties above the bar chart.
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The Properties window opens.
2

3

On the Graph tab, select the following:


Select Ocean for style.



Select 3D for depth.



Select Vertical for grid lines.

On the Bar tab, select the following:


Select Horizontal for orientation.

V iew the Reports

4

5

On the Axis tab, select the following:


Select Tahoma for labels.



Select Tahoma for values.

On the Legend tab, select the following:


Select Top for position.



Select Shadow for border.
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Click OK.
The bar chart is redrawn to your specifications.

Save the Report
When you have a report layout that you believe is useful, save it.
1

Select File > Save As.

V iew the Reports

2
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Name the view, for example Baby Bank Bar Chart, and click OK.
The view is saved as a data exploration and can be opened again and shared with
others for review. It is saved under your user profile in the BIP tree.
Foundation\BIP Tree\Users\<<your user ID>>\Data Explorations

Note: If the cube for your summary report is regenerated in the SAS Profitability
Management rich client, then your saved data exploration views must be
refreshed to display the new content.

View the Detail Report
1

Click Profitability Management at the top of the window to return to the SAS
Profitability Management Web workspace.

2

Click the Detail Reports tab.
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3

Select the CustID detail report that you defined previously (for the Baby Bank
model).

4

Type 00018 in the Search For field to report on that customer, and then click
View.

The report for customer 00018, Lynn York, is displayed.

On review of Lynn York’s profit and loss statement, you can see the details of her
relationship with Baby Bank.


You can notice that she has a credit card and a loan and has been paying a
significant amount of credit card interest.



You can notice she has also been paying a lot of unsecured loans interest income,
but she does not have a mortgage.



She might be a prime target for a marketing communication for a second mortgage
to consolidate her existing debts.

V iew the Reports
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You can also notice that she does not have any interest expense, which indicates
that her savings, CDs, and investments are not with Baby Bank. So she may be a
prime target for marketing those products.



When you scroll to the next page and see the bottom line, you notice that Lynn
York is a very profitable customer for Baby Bank.
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Data Requirements for the Model
The following graphic shows the development sequence in SAS Profitability
Management from the input of various data tables to the output of OLAP cubes. A
detailed description of each of the input tables follows in this chapter.

106 Behavior Table

Chapter 13

For all data tables, data validation needs to occur before the content is loaded into
SAS Profitability Management. Review source tables to eliminate special characters.
The following list contains the reserved characters to remove. These characters are not
valid in cubes, where profit and loss reporting will be done: . , ; ' ` : ? * & % $ ! - + = ( ) [ ]
{ } / \.

Behavior Table
The behavior source table holds all of the content to provide the cost and the revenue
values that will be assigned to the transactional volumes based upon the defined rules.
The behavior table contains the following fields:
Name

Maximum
Length

Description

Time

Char 32

The period for the transaction
cost

ID

Char 32

The ID for the behavior

Name

Char 32

The name of the behavior

TotalValue

Num 8

The total source amount to be
divided

UnitValue

Num 8

The unit cost for each transaction
with this source

Note:
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Only one of the UnitValue and TotalValue columns can contain a non-zero value
for any row of the behavior table.



The order of the columns is arbitrary (you identify the columns during model
definition).



The name of the columns is arbitrary (but, if you use these names, they are
mapped automatically).

The following graphic shows the behavior table, BEHAVIORS, for the Baby Bank
model:

The following graphic shows how a behavior table is related to other files:
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Period Dimension
The period dimension table defines the time periods used in a model. Depending on
your business reporting needs, you may have more or fewer levels in the period
hierarchy.
A period dimensions table can contain the following fields:
Name

Maximum
Length

Description

ID

Char 32

The identifying value for the
period

L1_Scenario

Char 32

Top-level dimension member
value (for example, Actual or
Budget)

L2_Year

Char 32

Second-level dimension member
value (for example, 2008)

L3_Quarter

Char 32

Third-level dimension member
value (for example, 2008_Q4)

Note:


The order of the columns is significant.



The name of the columns is arbitrary.



The number of levels is arbitrary.

The following graphic shows the period dimension table, DIM_PERIOD, for the Baby
Bank model:
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Custom Dimensions
A definition table must be loaded for each dimension used in the SAS Profitability
Management model and in your transactional tables. Transaction tables have a column
for each cutom dimension defining the crossing where transactional values are collected.
All dimension names must be a single word.
The Baby Bank model contains the following custom dimensions:


Channel



Customer



CusType



Product



Region.

DIM_CHANNEL
The following table shows the channel dimension. It is a one-level table that defines
the following channels:
L1_Channel
ATM
BRH
Call Center

The following graphic shows the entire table contents:
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DIM_CUSTOMER
The following table shows a portion of the contents of the DIM_CUSTOMER
dimension. You can see that the table defines two types of customers: personal and
bsiness. For personal customers, the table contains both last name and first name. For
business customers, the last name contains the name of the business, and the
FirstName field is blank.
L1_Type

L2_LastName

L3_FirstName

Personal

Adcock

James

Farm

Peter T.

Aden

Shelly

Business

Logic Consulting
Metrogas SA
FASHBI Worldwide

The following graphic shows part of the contents of the DIM_CUSTOMER table:
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DIM_CUSTYPE
The following table represents the contents of DIM_CUSTYPE. It shows the levels in
the dimension.
L1_CType

L2_CType

Personal

Retail Consumer Banking
Small Business Banking

Business

Private Banking
Corporate Banking

The following graphic shows the entire contents of DIM_CUSTYPE.
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DIM_PRODUCT
The follow table represents the contents of DIM_PRODUCT.
L1_Product

L2_Product

Credit Products

Secured/Mortgages
Unsecured

Deposit Products

Checking
Recurring
Savings
Term

Fee-Based Products
Other Products
Revolving Credit Products

Credit Cards
Overdrafts

Third-Party Products

The following graphic shows the entire contents of DIM_PRODUCT.
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DIM_REGION
The following table represents only a portion of the DIM_REGION dimension. It is
included here to help you understand the level structure. The region dimension has four
levels.
Area

Country

State

City

North America

Canada

Ontario

Don Mills
Metcalfe

Quebec

St. Hubert Quebec
St. Laurent
Town of Mont Royal

Mexico

Saskatchewan

Sheffield

Coahuila

Saltillo

Mexico

Cuauhtemoc
Colinia Granada
Polanco

South America

Brazil

Brazil

Uberlandia - Mg

Pe Brazil

Itapissuma

Sao Paulo

Ribeirao Preto
Sao Paulo

Costa Rica

Costa Rica

San Jose

Ecuador

Ecuador

Guayaquil

Uruguay

Montevideo

Montevideo

Venezuela

Caracas

Altamira

The following graphic shows the corresponding part of the actual table contents.

114 Rule Definition Table

Chapter 13

Rule Definition Table
A rule provides


Selection criteria that determine which rows are selected in the transaction tables
for calculation of values (revenue or cost).



driver formula that provides the calculation necessary to assign an amount for the
source values (cost or revenue) from the behavior table to selected records in the
transaction tables.

Rules can be defined through an interactive method in the SAS Profitability
Management client user interface, or rules can be imported from a specific source table,
using the appropriate rules definitional syntax to provide the selection logic and the
driver quantities.
The rule definition table contains the following fields:
Name

Maximum
Length

Description

TableGroup

Char 64

The name of the transaction table
group to which the assignment
rule will be applied

AssignmentRule

Char 64

The name of the assignment rule;
this must be unique within the
model

SelectionCriteria

Char 1024

The expression defining the filter
logic

DriverFormula

Char 1024

The formula defining the
calculated quantity

Note:


The order of the columns is arbitrary (you identify them during import).



The name of the columns is arbitrary (but, if you use these names, they are
automatically mapped during import).

The following graphic shows the rule import table, RULES, for the Baby Bank model:
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Rule Selection Criteria
Rule selection critera filter the transaction table rows that are calculated. You can
filter by


text values



numerical properties



dimensional member values



matching fields in the behavior table

Text Values
Operators:

=, not =
And, Or

Syntax:

text property = ‘filter value’

Example:

AssignmentRule = 'ATM_CHK_Check balance'
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Numerical Properties
Operators:

=, not =, <, <=, >, >=
And, Or

Syntax:

column operator value

Example:

AMT > 1000

Dimensional Member Values
Operators:

IsChildOf
And, Or

Syntax:

IsChildOf (source column, [dimension table].[value]

Example:

IsChildOf(channel, '[dim_channel].[ATM]')

Example:

IsChildOf(channel,'[dim_channel].[ATM]') And
IsChildOf(product,'[dim_product].[deposit
products].[checking]')

The IsChildOf operator allows you to select from any point in a dimensional
hierarchy tree, and all children of that hierarchy are selected as matching. In the
following graphic, these selection criteria pick out Secured Mortgages (SCR) and
Unsecured (UCR) because they are both children of Credit Products (and are in the ATM
channel):
IsChildOf(Product, '[DIM_PRODUCT].[Credit Products]') AND
IsChildOf(Channel, '[DIM_CHANNEL].[ATM]')
Note: This rule does not exist in the Baby Bank tutorial model. It is shown here for the
purpose of illustration.
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Matching Fields in the Behavior Table
Operators:

MatchColumns
And

Syntax:

MatchColumns(Transaction(column_name), Behavior(column_name))

Example:

MatchColumns(Transaction(Product),
Behavior(Product))

The match Behavior operator enables you to compare fields between the behavior
table and a transaction table. The selection criteria are met when the value of every
matching column in the transaction table row equals the value of the corresponding
matching column in the behavior table row.
For example, “Product” in a transaction table can have a corresponding matching
column “Product” in the behavior table. Note that the “Product” field in the behavior
table is not a required field. You can add additional fields to the behavior table for
matching purposes.
Both text and numeric column types are supported for matching fields. You can
combine multiple match behaviors with the AND operator.
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Rule Driver Formula
The result of a driver formula is the driver quantity. The driver formula can be based
on


a single numeric property



multiple numeric properties



a single entered value



a SAS numeric expression.

Single Numeric Property
Example:

AMT

Multiple Numeric Properties
Example:

COUNT * .05 + AMT * .01

Single Entered Value
Example:

15

SAS Numeric Expression
The driver formula can consist of any SAS numeric expression. Columns referenced in
the formula must be in the input transaction table.
Example:

MAX(Requests, Complaints)*.25

Example:

EUROCURR(AMT,’eur’,’frf’)

Example:

IF CustID ='C00650' THEN (0.54*Distance)
ELSE IF CustID ='C00692' THEN (0.74*Distance)
ELSE (0.23*Distance)

Rule/Behavior Associations
The association table is used to correlate rules with behaviors. Each rule can be used
by multiple behaviors, but each behavior can only have one rule. The association process
can be done interactively in the user interface or the associations can be defined based
upon an import table to load.
The rule associations table contains the following fields:
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Name

Maximum
Length

Description

BehaviorId

Char 32

The ID of the behavior table row

BehaviorName

Char 55

Optional field. The name of the
behavior

TableGroup

Char 64

The table group to which the rule
is applied

AssignmentRule

Char 64

The name of the associated
assignment rule. This name must
be unique within the model

Note:


The order of the columns is arbitrary (you identify them during import).



The name of the columns is arbitrary (but, if you use these names, they are
automatically mapped during import).

The following graphic shows the rule associations table, ASSOCATIONS, for the Baby
Bank model:
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Report Hierarchy
The report hierarchy table defines the dimension hierarchy for drilling down in profit
and loss reporting. The number of levels in the hierarchy is a critical model design
decision, and it is subject to the ultimate reporting needs for the business managers to
make decisions.
The report hierarchy table contains the following fields:
Position

Name

Maximum
Length

Description

1

ID

Char 32

The ID of the behavior table row
for this member

2

L1_Profit

Char 32

1st level dimension members for
the hierarchy

3

L2_Profit

Char 32

2nd level dimension members for
the hierarchy

4

L3_Profit

Char 32

3rd level dimension members for
the hierarchy

5

L4_Profit

Char 32

4th level dimension members for
the hierarchy

5

L5_Profit

Char 32

5th level dimension members for
the hierarchy

Note:


The order of the columns is significant.



The name of the columns is arbitrary.



The number of levels is arbitrary.

The following graphic shows the report hierarchy table for the Baby Bank model:
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The report hierarchy table defines the dimension hierarchy for drilling down into the
profit and loss report. The number of levels in the hierarchy is a critical decision in
model design and is subject to the ultimate reporting needs of the business managers to
make decisions.

Report Hierarchy to Resulting Report
In the following graphic, you can see how the columns in the report hierarchy relate to
the columns in the display table of a summary report.
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Behavior Table to Report Hierarchy
Let’s take a closer look at the report hierarchy – in particular the relationship
between the report hierarchy and the behavior table. In the following graphic you can
see that items in the behavior table occur at the lowest level in the report hierarchy
table. Because the hierarchy can have different depths at different places, this means
that the behavior table items can occur in different columns (different depths) in the
report hierarchy table. Also, note that intermediate levels can correspond to custom
dimensions (for example, the channel and product dimensions at levels 3 and 4) but they
do not have to. For example, interest income and interest expense (in the first six rows
of the report hierarchy table) have no existence outside the report hierarchy table itself.

Report Layout
The report layout defines the calculation logic for the profit and loss statement.
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A report layout table contains the following fields:
Position

Name

Maximum
Length

Description

1

ID

Char 32

The ID of the behavior table row
for this member

2

Name

Char 32

The name of the behavior for
display on the report

3

Formula

Char 255

For calculated rows, the formula
for the calculation based on the
IDs

4

RowOrder

Numeric 8

The position of the row in the
profit-and-loss report

Note:


The column names must be exactly as shown.



The order of the columns is arbitrary.

The following graphic shows the report layout table for the Baby Bank model:

Report Layout to Resulting Report
The report layout controls how the OLAP viewer displays the cube when it is first
opened. You can see in the following graphic that the report layout table controls


The order in which columns are displayed. REPORTLAYOUT causes income
variables display before expense variables.



Whether fields are initially displayed expanded or collapsed. You can see in the
following graphic that the Servicing Effort field is displayed collapsed because it
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is included in REPORTLAYOUT without any of its children showing. By contrast,
the Interest Income field is displayed expanded to level 2 because its children
(credit card interest income, loan interest income, mortgage income) are included
in REPORTLAYOUT but not the parent – Interest Income.
Note: The OLAP viewer always shows the highest level of a dimension. The report
layout determines to what level the highest dimension is expanded when the
report is initially opened. A user can navigate the dimension, expanding and
collapsing it at will.


Totals. For example, line 4 of the report layout displays a total whose formula is:
[10001]+[10002]+[10003] – that is line 1 + line 2 + line 3.
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Summary: Behavior to Hierarchy to Layout to Report
The following graphic summarizes the relationships among the behavior table, report
hierarchy, report layout, and resulting OLAP report.

Transaction Tables
A single SAS Profitability Management model can have multiple transaction tables,
depending upon how the data is collected for your corporation. A table group is a set of
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tables sharing the same schema (same columns with the same field definitions). In a
table group, each table represents one period of the period table.
There must be a separate transaction table for each period in the model. For a single
SAS Profitability Management model, multiple table groups will likely be defined. It is
also likely that multiple rules will use the same source table group.
Transactional tables layout is affected by the rules definition process (filter logic and
driver logic). There are three critical aspects to every transaction table: dimensional
signature, filter criteria selection logic, and quantities for calculation.
A transaction table contains the following columns and must conform to the following
rules:


Each column must have the length shown.



The position of columns is arbitrary.



The name of columns is arbitrary.



The number of columns in a transaction table is arbitrary.



A transaction table can contain other columns not specifically used by SAS
Profitability Management.

Name

Dimensions
(1 to n)

Driver quantities
(1 to n)

Optional columns
(0 to n)

Maximum
Length

Char 32

Description
Each value identifies the row (in
a custom dimensions table) for
this transaction.
The number of dimensions is
optional (minimum 1).

Numeric 8

A rule's driver formula uses these
values to calculate the driver
quantity for a transaction.
The number of columns is
optional (minimum 1).

optional

You can add any number of
optional text or numeric columns
of any length to a transaction
table.
For example, you can use an
optional column for matching
fields in a behavior table.

ABMCost Group
The ABMCost table group consists of the following two transaction tables:


LOAD_TRANS_Q4A – for the 4th quarter actual period



LOAD_TRANS_Q4B – for the 4th quarter budget period.

The schema for the ABMCost group consists of the following fields:
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Field

Name

Description

1

CustID

ID of customer dimension

2

Product

ID of product dimension

3

CustType

ID of customer type dimension

4

Region

ID of region dimension

5

Channel

ID of channel dimension

6

AssignmentRule

Text string for use in filtering rows with that string. Rows that
are selected are assigned the behavior cost

7

Count

Value of 1 used in driver

8

AMT

Number of occurrences, used in driver

The following graphic shows a portion of the contents of LOAD_TRANS_Q4A:
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CallCenter Group
The CallCenter table group consists of the following two transaction tables:


CALLCENTER_Q4A – for the 4th quarter actual period



CALLCENTER _Q4B – for the 4th quarter budget period.

The schema for the CallCenter group consists of the following fields:
Field

Name

Description

1

Product

ID of product dimension

2

CustType

ID of customer-type dimension

3

Region

ID of region dimension

4

Channel

ID of channel dimension

5

Communication

number of calls

6

Complaints

Number of complaints

7

Inquiry

Number of inquiries

8

Requests

Number of requests

9

CrossSell

Number of sales calls

10

Offer

Number of offers

11

Count

A value of 1 indicates an evenly assigned item

The following graphic shows a portion of the contents of CALLCENTER_Q4A:

Revenue Group
The Revenue table group consists of the following two transaction tables:
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REVENUE_Q4A – for the 4th quarter actual period



REVENUE _Q4B – for the 4th quarter budget period.
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The schema for the Revenue group consists of the following fields:
Field

Name

Description

1

Channel

ID of channel dimension

2

CustID

ID of customer dimension

3

Product

ID of product dimension

4

CustType

ID of customer type dimension

5

Region

ID of region dimension

6

AMT

Calculated specific revenue

7

ID

Behavior ID for revenue items

The following graphic shows a portion of the contents of REVENUE_Q4A:
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Baby Bank Conclusions
You have successfully created a SAS Profitability Management model, calculated
transaction tables, and generated cubes. You have reviewed profit and loss reports at
both a summary and a detail level. You have reviewed those results to draw conclusions
about your customers’ behavior and the action Baby Bank can take to focus specific
attention on custerm needs and how they impact the corporate profitability of Baby
Bank. Baby Bank can now analyze its customers, channels, products, customer types,
and regions to plan for a successful and profitable future.
SAS Profitability Management enables organizations to use more accurate
profitability measures to make better decisions for customers, products, and channels.
With SAS Profitability Management, decisionmakers can define and redefine the
segmentation reports that they need on the fly. SAS Profitability Management enables
business managers to track the profit performance of customer groups or individual
customers, product groups or individual SKUs, channels or specific branches –
presenting drill-down and at-a-glance views into revenue, cost, and other metrics so they
can identify and investigate problems that can improve the bottom line.

Additional Features
Enhance your SAS Profitability Management Solution with


SAS Activity-Based Management enables strategic and operational decisions that
maximize profit, reduce costs, and streamline processes by determining the cost of
those processes and the profitability of products, customers, and business
segments. In SAS Activity-Based Management, you can mark accounts as
behaviors and then publish the behaviors for use in SAS Profitability
Management.



SAS Customer Profitability for telecommunications is a component of SAS
Telecommunications Intelligence Solutions, a Suite of integrated solutions that
are built on an enterprise data architecture optimized for telecommunications
providers.



SAS Customer Intelligence for Banking can help you understand an individual
customer’s behavior at every touch-point throughout the life cycle of the
relationship. By integrating data across channels, product silos, and external data
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and market sources, you create a holistic picture of the current, potential, and
future value that each customer delivers, as opposed to fragmented facts on
customer risk, behavior, account activities, and operational costs. Using predictive
analytics, you can forecast customer behaviors such as attrition and credit and
load risk so you can devise more effective cross-sell and up-sell strategies.

What to Do Next: Useful Links


SAS Worldwide Web for links to everything SAS
http://www.sas.com/



SAS Worldwide Training
http://support.sas.com/training/index.html



BetterManagement – for useful business domain white papers and web casts
http://www.bettermanagement.com/



SAS Solutions – Links to other powerful business solutions from SAS
Focused Solutions for your Business Challenges: To lead with confidence and
outpace competitors, you need to make accurate decisions faster than ever. SAS
equips your organization for success by helping you answer more questions, for
more people, across more departments than any other analytic applications suite
provider.
http://www.sas.com/solutions/index.html



SAS Business Intelligence:
SAS Business Intelligence gives you the information, when you need it, in the
format you need. By integrating data from across your enterprise and delivering
self-service reporting and analysis, IT spends less time responding to requests,
and business users spend less time looking for information – so more time is spent
on making better, more informed decisions
http://www.sas.com/technologies/bi/index.html



SAS Analytics:
SAS Analytics give you THE POWER TO KNOW® how to integrate data from
across your enterprise and then quickly transform that data into shared insights.
We offer a comprehensive suite of analytics software to help you reduce
uncertainty, predict with precision, and optimize performance
http://www.sas.com/technologies/analytics/index.html



SAS Merchandise Intelligence
Only SAS Merchandise Intelligence provides real intelligence at every step of the
merchandising life cycle. With this collection of software and services, you can
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maximize the profitability of the merchandising process while improving customer
loyalty and satisfaction levels. Retailers get reporting, planning, forecasting, and
optimization at critical points through the planning process, which leads to faster
and better decisions.
http://www.sas.com/industry/retail/merchandise/index.html


SAS Customer Intelligence
Only SAS Customer Intelligence provides the vital knowledge needed to help
organizations build an integrated platform for enterprise marketing management.
With SAS Customer Intelligence, campaigns and programs implemented across
channels will be effective, consistent, and timely. They will target the right
customers with the right offers. And with the power of SAS predictive analytics,
you can be confident that actual results will match predicted ones, even before you
spend anything on a new campaign.
http://www.sas.com/solutions/crm/index.html

Your Turn
We welcome your feedback.
•

If you have comments about this book, please send them to
yourturn@sas.com. Include the full title and page numbers (if
applicable).

•

If you have comments about the software, please send them to
suggest@sas.com.
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